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Mysticgeek, a blogger over at The How-To Geek's realm, posts a step-by-step tutorial to creating flow charts with presentation-worthy looks in Microsoft Word 2007. If you've got an eye for design, you can add shadows, 3-D effects, and subtle color shading to your boxes and lines, but if you're just looking for basic flow chart functionality, you'll only
need to make it halfway down the post. Lacking a copy of Office 2007? Check out a free online tool like Project // DRAW, or do it on paper with a five-minute flowchart template from blogger John Richardson. Create A Flow Chart In Word 2007 [Mysticgeek's Realm | The How-To Geek] Featured Bonus Content: Download 57 Flow Chart Templates for
FREE! Click Here To Download It. To improve efficiency in your organization, all team members and employees must be on the same page regarding your company’s procedures and processes. That way, everyone will know exactly what they need to do at all times, and who they need to collaborate with on the team to complete a specific task. While
there are many systems available for working collaboratively and efficiently in a team, flowcharts have been exceptional when it comes to establishing efficiency in many organizations. Flowcharts visualize the steps that your employees must take to complete a process or procedure in your organization. Businesses have been using flowcharts for
years, and they’re still relevant to date. In this detailed guide, you’ll learn everything you need to know about flowcharts. Also, you’ll find access to 57 free flowchart templates for Word, PowerPoint, Excel, and Google Docs that you can download, tweak and use for your own business. Table of Contents: Chapter One: What Are Flowcharts? Chapter
Two: Types of Flowcharts Chapter Three: Uses and Advantages of Flowchart Templates Chapter Four: Flowchart Templates for Word Chapter Five: PowerPoint Flowchart Templates Chapter Six: Flowchart Templates for Excel Chapter Seven: Flowchart Templates for Google Docs Chapter Eight: Flowchart Templates Frequently Asked Questions
Chapter Nine: Create and Manage Your Flowchart Templates with SweetProcess Flowcharts are graphical representations of how tasks, processes, or systems should flow. With them, you can document, plan, refine and visualize all the available steps in a workflow. The best part is that flowcharts capture everything in a single chart, which allows
you to easily spot overlapping tasks, assign tasks efficiently, or break down complex tasks. Now let’s dive into more in-depth information about what flowcharts are, why you should use them, and who benefits most from them in an organization. A flowchart is simply a graphic representation of a procedure. They are frequently used to document,
analyze, plan, enhance, and convey complex processes in clear, simple diagrams. Let’s say you’re a copywriting agency that helps business owners design landing pages with high conversion rates. Some of the procedures you’ll follow include: Understanding the company’s use cases and featuresInterviewing their current customersTranscribing the
interviewHighlighting the common pain points mentioned by the customersWriting the first draft of the copySending it over to the client for inputs and correctionsAdding screenshots, annotations, and videos to the copySending the final copy to the client for approvalDesigning the landing page Publishing it As you can see, this is a procedure that you
follow in your agency to deliver your services to clients. By using a flowchart, you’ll turn these steps into a graphical representation that anyone can look at and understand almost immediately. Flowcharts can range from simple hand-drawn diagrams to detailed computer-drawn graphics illustrating several processes and paths. They are one of the
most widely used diagrams in the world. They have been adopted by technical and non-technical professionals in different industries. Now that you have a better understanding of what flowcharts are, let’s talk about why you should use them in your organization. Flowcharts illustrate the steps that are required to complete a specific task. Simply put,
if you want your team to identify the overall structure of a system, understand how to navigate a particular task, or study a process for improvement, creating a flowchart is the best way to achieve it. Here are some other reasons why using a flowchart makes sense for your business: For instance, if you want to find out where you should focus to
increase the efficiency, quality, or performance of a job schedule or system, you should use a flowchart to display vast amounts of actual information in a single screen. The flowchart makes it possible to manage everything from one view. It allows you to assign distinct color schemes to various activities and procedures to make them easier to
understand.It helps you with concept mapping. If you have an idea that you want to communicate to the rest of your team, the most efficient way is to chart out a flow that displays how individual parts relate to achieving synergy. Doing this gives room for knowledge organization and brainstorming. It simplifies fault troubleshooting, process
documentation, continuous process improvement, and makes it easy for you to create training materials and workflow guides for your team. Let’s move on to who benefits most from the use of flowcharts. Here is the fact: Anyone from any industry can benefit from the use of flowcharts. These include:
ManufacturingConstructionAgricultureRetailMiningProductionTransportationFood industryFinanceTelecommunicationsMarketingReal estateEducationEngineeringHealthInsuranceAnd so many more By using a flowchart in your organization, you’ll provide your company’s stakeholders from all levels with information that helps them grasp the process
better, and determine which steps are superfluous and where progress needs to be improved. It can also allow you to communicate in a flash by clarifying your work progress in a simple, visual way to help your team members understand what they should do next in a step-by-step manner. It’s important to note that there are different types of
flowcharts, which are suited for specific purposes. As the name implies, this flowchart provides a high-level picture of a specific process by outlining six to ten major steps. It shows the primary blocks of action or major system components of a process. It is particularly valuable in the early stages of a project since they aid in the identification of
improvement priorities. The detailed flowchart delves deeper into the entire work process and lays down all the phases and procedures. By definition, it is a flowchart that thoroughly highlights a process by depicting individual stages in detail. Usually, these stages are in dozens or more. It simplifies the identification of complex, superfluous steps,
and other issues in the process and can be used when standardizing or changing the process. The deployment flowchart shows the department and sometimes the person on the team who is in charge of each process or procedure. Flowcharts for deployment show the steps in a process as well as who or what group is involved in each step. For
instance, if you want to build a deployment flowchart as shown above, you need to identify the groups responsible for each task at the top, i.e., production, administration, and marketing, as shown. This deployment flowchart combines two important characteristics which are the order in which a process’s steps are performed and the person
responsible for each step. Its advantage is that it shows how work is passed from one person or group to another, and reveals possible misunderstandings and errors that often occur along the line. Flowchart templates are great time savers and resource managers. Instead of having a team of designers studying and simplifying work processes across
different sections, you can assign a staff to go from one department to another so they can understand the work processes better and use flowchart templates to create templates easier and faster. Also, flowchart templates help new team members gain a better understanding of the work process so that they gradually increase team productivity. Here
are different use cases and advantages of using a flowchart template. Flowchart templates are used to create sales processes and track the progress of potential opportunities. This assists you in leveraging data to identify growth opportunities. They help your team make decisions about pricing bundles or customer quotes. This is because it
highlights the different tasks and shows you where to invest more resources. It also improves consistency in policy documentation and communications. They are used to display and visualize items such as raw materials, chemicals, or other inputs before they go into the making of a product. They highlight the entire production process in detail so
that you can demonstrate dependencies and figure out bottlenecks. They are used to create procedures for quality assurance and consistent evaluation in manufacturing. They are used to reduce bottlenecks when programmers align how users interact with a page or an application. In programming and web development, they are used to ensure
consistency when describing the structure and organization of the code to your team. This leads to uniformity in the visual representation of algorithms. Flowchart templates help you save time and money. When communicating a complex task, the templates help you represent those complex entities in a very simple logic that is easier to understand,
thereby saving you and your team scarce resources. During analysis, flowchart templates allow for effectiveness as they simplify the problem and make solutions more comprehensible. They make it easier for you to debug programmatic systems and efficiently test projects. They also help in efficient task assigning as it becomes easier to connect
individual skills to peculiar tasks. They provide consistency and uniformity in the creation of task pathways and help to reduce errors in task documentation. Flowchart templates increase the flexibility and efficiency of program maintenance. They ensure that operating programs have a seamless workflow. Flowchart templates are difficult to alter or
modify, especially in large organizations. Whenever you make any changes to a flowchart template, your procedures and processes will be affected as well. In a large organization, this might result in drastic changes to your existing procedures and processes that might take months to figure out. If you have a complex organizational structure, your
flowchart template will most likely look clumsy. This will make it difficult for your team members and management team to understand. Any error or oversight made from the process or procedure used to create the flowchart is costly. This will lead you to spend more time and resources to redraw or recreate the flowchart and its template from
scratch. Microsoft Word is one of the oldest and most popular tools for making a flowchart template. We’ve compiled 20+ free flowchart templates in Word below, which you can download, tweak, and use for your organization. Budgeting flowchart template Click here to download this Flow Chart Template The budgeting flowchart template allows the
management team to define financial goals, track expenditures, and take corrective action to maximize profit potential. With this flowchart template, targets are defined, previous expenditures are evaluated, resources are estimated, and permissions are gained to confirm the final work output. Medical flowchart template Click here to download this
Flow Chart Template Medical flowchart templates aid in the diagnosis, investigation, and treatment of a variety of ailments in a healthcare organization. This could involve the flow of the branches of medicine, and pointers to clinical practice case studies. The flowchart shows different ailments and provides pointers and structures for treating them.
This could be used in andrology, cardiology, complementary and alternative medicine, dermatology, medications for drugs and alcohol, etc. Change management process map template Click here to download this Flow Chart Template This change management flowchart template is a visual aid that shows you how the change management and control
process is implemented across the organization. It entails the changes that have been made, the controls that have been implemented, and the framework that has been used to manage these changes. Marketing flowchart template Click here to download this Flow Chart Template This marketing flowchart template is a written and graphical
depiction of all the stages required to perform a set of marketing duties. From the definition of marketing goals, research and analysis, budgeting and implementation, and more, it covers all the steps to achieving great outcomes from your marketing activities. Social media flowchart template Click here to download this Flow Chart Template The
social media flowchart template is a diagram flow that depicts the detailed steps to use when managing a social media page for your organization. With this template, users will find better ways and directions to interact with new social media platforms that may seem difficult for them. Project flowchart template Click here to download this Flow
Chart Template The project process flowchart template is useful for visualizing the processes that must be followed during the project management process. It guides you through the stage of project creation, team selection, and task assignment. This template provides an effective walk-through to building projects from beginning to end. Customer
service flowchart template Click here to download this Flow Chart Template The customer service flowchart template is a graphic representation of a company’s customer service procedure which includes the customer request, the initial response sent to the customer, how the issue is channeled to the appropriate department for resolution, and so
on. This template visualizes each step, hence aiding teamwork and improving the overall customer experience. Click here to download this Flow Chart Template This work flowchart template highlights the business process from beginning to end in a step-by-step, linear manner. It shows the flow of individual tasks, behaviors, or resources between
individuals or groups. For example, when a customer calls the support unit of an organization, it explains how the support personnel can give details of the available services, and walk the customer through the process until the problem gets solved. Operations flowchart template Click here to download this Flow Chart Template The operations
flowchart template visually shows the steps in a process and the specific order it follows. For instance, in quality improvement, this flowchart guides you to identify how to create a scale that serves as a standard, and how to measure the created outcome by the scale to achieve optimal results, and reveal areas of improvement priorities. Patient
flowchart template Click here to download this Flow Chart Template The patient flowchart template captures the movement of patients through a healthcare facility. It highlights the medical care, physical resources, and internal mechanisms required to move patients from admission to discharge while ensuring quality and patient/provider
satisfaction. Yes/No flowchart template Click here to download this Flow Chart Template The yes/no flowchart template shows how different types of categories for an issue are acknowledged. This is useful when you want to present the findings of a survey. Sometimes called the two-fold or butterfly chart, this flowchart highlights the percentage
values of the two sectors or the decision-making process. Click here to download this Flow Chart Template The application flowchart template is used to create and document simple applications processes and programs. They visualize the process of planning, designing, creating, and marketing an application. It allows you to visualize how the app
development process works, as well as identify the less-obvious elements such as defects and bottlenecks. Electronic design flowchart template Click here to download this Flow Chart Template The electronic design flowchart template is used for electronic design flows, process activities, and user representations. Designers use these flexible shapes
to depict, design interactions, and present stakeholders with easy-to-understand electronic design maps. It also includes features like lines to connect labeled, standardized symbols to represent what users can do in interactive environments. Sports flowchart template Click here to download this Flow Chart Template This sports flowcharts template
reveals how internal sports management is done. It shows how coaches, technical leads, and team members’ responsibilities are outlined and how processes get shared or transferred between different teams and departments. It breaks down games into recreational and professional purposes and ensures that the team gets the necessary permission
to achieve its tasks. Email marketing flowchart template Click here to download this Flow Chart Template The email marketing flowchart templates are email sequences that are triggered and delivered automatically. They highlight how you will collect email subscribers, the process of sending them emails, and the next point of action depending on
how they interacted with the initial email. They also show the flow of sending relevant, scheduled, and triggered emails to subscribers or prospects by using the software. Company flowchart template Click here to download this Flow Chart Template The company flowchart template is a graphical depiction of how a business interacts with its
customers, vendors, and employees. It’s used to have a top-down understanding of how a process of interacting with customers works. It also highlights the steps that your team follows to interact with the different products, invoicing processes, and events affecting results. Production flowchart template Click here to download this Flow Chart
Template This production flowchart template shows how to plan and make your product in stages, the equipment and tools you’ll need, and quality control checks to put in place. It helps you initiate purchasing orders, receive and confirm the order, then select the product line to dispense, and how to start bulk production. Decision tree flowchart
template Click here to download this Flow Chart Template The decision tree flowchart template is an easy tool for fast decision-making. It has internal nodes that represent a certain feature test (e.g., whether a coin flip will come up heads or tails), each leaf node represents a class label (decision made after computing all features), and branches
represent feature combinations that lead to those class labels. Sample audit flowchart template Click here to download this Flow Chart Template This audit flowchart template is used to show each step an auditor must take when analyzing a company’s finances. The findings of an auditor may have financial and legal implications for a corporation. It
presents when audit schedules are created, the specific process calls, file audit report, correction action, etc. If you’re an auditor, this helps you to be thorough and precise in your work process. Finance work flowchart template Click here to download this Flow Chart Template The finance workflow template chart assists independent financial
experts, risk analysts, and firms in streamlining the entire time-consuming and repetitive financial operations such as travel and purchase requests. This will then allow the personnel or team to work more productively and efficiently. Project management flowchart template Click here to download this Flow Chart Template The project management
flowchart template is best used for creating, selecting, planning, and managing projects. From idea proposition, requesting a review, creating and approving business cases, and delivering projects, it covers the entire stage. It also highlights the internal operations, steps in a process, and predictable outcomes of managing a project lifecycle.
Research project flowchart template Click here to download this Flow Chart Template This research project flowchart template highlights the movements and actions within a complex system. It includes how to generate research ideas, writing out the background research and planning process, then the project draft. These qualitative research
flowcharts serve as a road map to help you move from the start of an investigation to a conclusion. Internship flowchart template Click here to download this Flow Chart Template The HR internship management system flowchart template allows you to manage the process of a candidate’s internship and industrial training in your organization. It
shows how interns are to address employees’ queries, and how the employee reviews and distributes company policies to them. It also involves administration and report preparation. Architecture flowchart template Click here to download this Flow Chart Template This architecture flowchart template abstracts the overall structure of a software
architectural planning system. It includes the interactions, constraints, and boundaries between its components. It shows how the initial project discussion is, how the information gathering and documentation goes, and the schematic design, etc. It’s a useful tool since it gives you a bird’s-eye view of the software system’s physical deployment as well
as a timeline for its progress. Powerpoint is an intuitive flowchart maker that companies have been using for years. We’ve compiled 13 free PowerPoint flowchart templates below which you can download, tweak, and use for your organization. Organizational structure flowchart template Click here to download this Flow Chart Template This
organizational structure flowchart template highlights a company’s structure. It shows the various positions, departments, and tasks that link different employees and the management team. It serves as a work relationship pointer to ensure that there is an effective work relationship in an organization. Circular flowchart template Click here to
download this Flow Chart Template The circular flowchart template model or diagram lets you visualize the flows of products and money between two distinct segments of the economy. It shows where enterprises sell certain goods and services, then reveals what they have produced in exchange for revenue from households. Data flow diagram
template Click here to download this Flow Chart Template This data flowchart template is typically a programming paradigm that divides computational actors into stages or pipelines that can run at the same time. It allows you to stream processing and analyze the reactive programming nodes that are present in a data flow. Cylindrical flowchart
template Click here to download this Flow Chart Template This cylindrical shaped 3D flowchart template reflects data that has been saved. It shows how information can be saved on a hard drive, magnetic tape, memory card, or any other type of storage device. It also shows how databases are kept intact, and how a data file is represented by a
cylinder. Behavior flowchart template Click here to download this Flow Chart Template This behavior flowchart template shows how human behaviors impact numerous factors happening around them. It establishes procedures for discouraging inappropriate behavior and decides which behaviors are managed in a particular setting. In schools, these
flowcharts support teachers in designing classroom management systems and consistently approach classroom-managed behaviors. It also helps them to explicitly re-teach the expectation of behavioral patterns, communicate with families, and provide options for replacement behavior. Communication flowchart template Click here to download this
Flow Chart Template The communication flowchart template shows how a process, system, or computer algorithm works. It involves the communication flowchart as the backbone of any corporation. It shows how important it is to ensure that workflows are feasible and easy for users to comprehend. Click here to download this Flow Chart Template
The HACCP flowchart template depicts a food operation’s process flow from raw ingredients to finished products. It is usually used by a team called HACCP Team or the Food Safety Team. This flowchart details the process of sourcing and collecting food raw materials, cleaning and processing them, and making them into finished products.
Manufacturing flowchart template Click here to download this Flow Chart Template The manufacturing process flowchart template shows the individual steps of manufacturing a product from start to finish. It involves the logical order of describing and selecting several processes for manufacturing, then adding the other technical, tactical and
strategic administration to the service delivery process and project plans. Project management flowchart template Click here to download this Flow Chart Template The project management flowchart template helps you to detail the actions and roles responsible for executing them. The inputs and outputs for each step are all included in managing
and ensuring quality in a given project. In addition, it keeps track of any document or other materials needed to carry out the actions. This flowchart provides clarity and transparency by avoiding superfluous and technical jargon that may confuse stakeholders and team members from understanding the project concept. Sales process flowchart
template Click here to download this Flow Chart Template The sales process flowchart template outlines the processes that each salesperson should take to convert a prospect into a customer. It details how each employee should address customers from their respective stations, showing them who they can refer customers to, and understand the
stages of the buyer’s journey. Supply chain flowchart template Click here to download this Flow Chart Template The supply chain flowchart template is a comprehensive and action-specific template that allows you to ensure effective end-to-end product delivery. It is used by most firms to manage their supply chain procedures so they can improve the
way their goods move from the raw material stage to the finishing and storing stage. Vertical swimlane flowchart template Click here to download this Flow Chart Template In this vertical swimlane process flowchart template, users can delineate task sharing and responsibilities for sub-processes within a business process. Though the swimlanes
flowchart can be positioned horizontally too, the swimlane map shows the process, decisions, and loops that divide events and activities into “lanes” to identify the individual or group responsible for each subprocess. Service flowchart template Click here to download this Flow Chart Template The service flowchart template makes service delivery
seamless. It’s specific to coffee making and shows how a coffee maker could involve the coffee grinder, pot, and mug in brewing coffee for a customer. It aids you in examining the connections between what your clients anticipate, the service provided by skilled people, and how well the service matched those expectations. It also helps in identifying
service gaps or areas that require improvement. Microsoft Excel is an underrated tool for making flowchart templates. We’ve compiled 12 free flowchart templates for Excel below, which you can download, tweak, and use for your organization. Process flowchart template Click here to download this Flow Chart Template The process flowchart
template shows the sequential steps of a process as well as the decisions that must be made for the process to function. It highlights every step as represented by a form and indicates the movement and direction of the process. Lines and arrows connect these forms. Organizational flowchart template Click here to download this Flow Chart Template
The organizational flowchart template is a valuable tool for firms to display their organizational structure. It helps you to present all your teams by levels, then shows how they can work together. It details how the captains of your organization steer the navigations officers and other crew members. Decision flowchart template Click here to download
this Flow Chart Template The decision flowchart template provides an easy way to make decisions. It helps to limit the numerous available options that you may have, identify and separate what’s good and bad, then help you listen to your gut to make fast decisions. It is a planning tool that analyzes what might go wrong in a plan under development
in a systematic manner, and how the countermeasures are being developed to prevent or mitigate wrong decision-making. Website flowchart template Click here to download this Flow Chart Template The website flowchart template allows you to structure the complexity of any existing or planned website. From the UI/UX designer side to the frontend software development, and the backend developers working on the website functionalities, with this flowchart template you’ll be able to strategize the product, UX, and content teams so they can comprehend everything on a website and plan how to add or rearrange material to optimize the user experience. Purchase process flowchart template
Click here to download this Flow Chart Template The purchase process flowchart template is also known as the procurement process flowchart. It is a skeletal architecture that illustrates how purchase and procurement take place or are managed within an organization. Process map diagram chart template Click here to download this Flow Chart
Template The process mapping flowchart template illustrates the flow of a process. It starts by examining the macro level of the process and working down to the degree of detail required to discover chances for improvement. This template helps to focus less on job titles or hierarchy, but on the process of effectively delivering on tasks. Document
management work flowchart template Click here to download this Flow Chart Template The document management flowchart template is used for capturing, generating, tracking, editing, approving, storing, retrieving, retaining, and destroying documents related to business processes. This template uses digital document processing to allow
businesses to reduce the amount of paperwork they have on hand, which can slow down day-to-day operations. E-commerce flowchart template Click here to download this Flow Chart Template The e-commerce flowchart template process outlines several aspects of a standard e-commerce website. It covers check out and payment, abandoned cart,
and delivery. It allows you to track certain circumstances that could occur. Healthcare work flowchart template Click here to download this Flow Chart Template The healthcare work flowchart template helps you to create an ordered and repeatable pattern for your healthcare’s agency business activity. It also helps you create a methodical
arrangement of resources into processes that change materials, deliver services, or process data. Construction flowchart template Click here to download this Flow Chart Template The construction flowchart templates highlight how construction is managed from the idea and approval stage, to the construction preparation, land survey, analysis,
excavation, and base check. At the basic level, it depicts the interaction between building phases, the ones that are dependent on the completion of others until the sequence reaches completion. It can be used as a subcontractor management reminder. Software development flowchart template Click here to download this Flow Chart Template The
software development flowchart template highlights how to build a software product or platform from the concept, inception, construction, iterations, to the production and retirement level. It has a representation of a procedure and system that is frequently utilized in a variety of fields to document, analyze, plan, enhance, and convey often complex
processes in clear, simple entities. Finance flowchart template Click here to download this Flow Chart Template The finance flowchart template helps you in the planning and analysis of processes that includes developing a strong financial plan, forecasting, budgeting, and analytical reports. It allows an organization to maintain and enhance its
financial situation. Google Docs isn’t just for collaborating with your team members alone. It is an effective tool for making a flowchart template. Below are eight free flowchart templates in Google Docs, which you can download, tweak, and use for your organization. Click here to download this Flow Chart Template This blank flowchart template
provides you with ready-made shapes and connectors that you can always use to create any flowchart of your choice. It’s simple to use and tweak for your specific use cases. Business flowchart template Click here to download this Flow Chart Template This business flowchart template defines all the stages and phases in the business process
development. It includes ideation, planning, analysis, budgeting, etc. Hiring process flowchart template Click here to download this Flow Chart Template The hiring process flowchart template shows the steps in the recruitment process. It itemizes the creation of the recruitment requirements, setting the criteria for employment, job advertising,
interview process, and sending the job offer. Mobile app process flowchart template Click here to download this Flow Chart Template The mobile app flowchart template contains the basic operations that the mobile app user will encounter while browsing through an app. The developer uses this to show how the app will operate and what the app’s
major features will be. Quality control flowchart template Click here to download this Flow Chart Template A quality control flowchart template is a useful tool for determining the cost of quality (COQ) by examining the frequency of events within a decision loop, as well as the input and output branches involved. This tool improves processes that are
selected for the project during the quality planning phase. And when issues develop, the quality control flowchart helps to determine how far the team has deviated from the specifications and assists in error correction. Creative agency flow chart template Click here to download this Flow Chart Template The creative agency flowchart template shows
the steps taken by a creative agency or department to complete a business transaction. It wrangles the creative process and enables the construction of regular checklists, making an otherwise chaotic process easier to follow and stay on track. Click here to download this Flow Chart Template The basic flowchart template uses diagrams consisting of
rectangles, ovals, diamonds, etc. to indicate the specific step required to achieve a particular task. It also includes arrows that are used to indicate flow and sequence. Payroll swimlane flowchart template Click here to download this Flow Chart Template The payroll swimlane flowchart template highlights the process of paying a company’s employees’
salaries. It is the procedure of calculating what is owed to employees for a given payroll cycle after deducting mandatory payments such as TDS, employee PF contributions, loans, meal coupons, and so on. Now that we have the 57 flowchart templates, let’s proceed to the frequently asked questions about flowcharts. In this chapter, you’ll find answers
to the FAQs about flowcharts and flowchart templates. A good flowchart should clearly illustrate the process and express it in a way that anybody can comprehend. The first step to make a flowchart is to put down all the ideas and steps in your head into paper. Once that is done, then you can use different tools like Microsoft Word, Google Docs,
Excel, and so on to bring the ideas to life. That said, here are some general steps that you should typically follow when making a flowchart. Determine the specific goal that the flowchart serves.Add the steps in the procedure or process, and use arrows to connect them.Split them into different pathways and add the decision trees where
necessary.Return to the previous steps to see if there are any errors or missing points. Aside from using Microsoft tools like Word, Excel, and Powerpoint, there are several tools to make a flowchart. These include: SweetProcess is an intuitive software for documenting your company’s standard operating procedures and processes easily and in one
place. Using SweetProcess, you can create a flowchart for the specific procedures that your team uses in your day-to-day activities. That way, you can become more efficient and achieve better results for your clients and customers. For example, if you’re an email marketing agency that helps clients schedule email sequences, you can create a
procedure outlining the steps that you follow to do this using SweetProcess. Here’s a step-by-step guide to do this on SweetProcess: Step 1: Click on “Create Procedure” from your SweetProcess dashboard. Step 2: Name the procedure and click on the “Continue” button. Step 3: You’ll be redirected to a new window where you can add new steps and
decisions to your procedure. Click on “Step” to add a new step. Step 4: In the new tab that pops up, you can name the step, and add some information describing what it’s about. Once done, click on “Finished Editing.” You can add as many steps as you want in the procedure here. Step 5: If you’re creating a flowchart that requires you to add a
decision tree, you can do that as well using SweetProcess. Simply click on the “Decision” button to do that. Step 6: Once you click on the Decision button, you can choose an answer that will trigger a specific decision, and the step you’ll be redirected to if that decision is chosen. You can add as many decisions as you want here as well. Step 7: After
adding the steps and decisions, you’ll have a step list that looks like this: Step 8: Once you’re adding steps and decisions to your procedure in SweetProcess, a flowchart is created automatically. Here’s what it looks like in the dashboard: Step 9: If you want to visualize the steps’ list in a flowchart, simply click on the “Print” button. Step 10: Once you
do this, you’ll be able to download a flowchart for your procedure, which you can share with employees and team members. This is what it looks like. As you can see, creating a flowchart for your procedure in SweetProcess is easy and straightforward. Gliffy has a simple drag-and-drop system with hundreds of templates to choose from. It supports
Windows and Mac and is used mostly by beginners because it’s seamless and easy to use and understand. SmartDraw is a top-value choice for flowchart software, with over 4,500 templates and CAD-like features. The tool has tons of ready-made templates that you can choose from. It also runs in a web browser or behind a firewall, and it has top-ofthe-line functionality. Lucidchart is a simple-to-navigate online flowchart software designed for users of any operating system. It also allows for easy remote team collaboration and integrates seamlessly with nearly all popular platforms. It is compatible with Windows, Mac OS X, and Linux, and has various options for integration. Cacoo is a leading
flowchart software that makes team collaboration simple, whether in real time or asynchronously. Team members can interact anytime and from anywhere using the web platform, which includes team comments, tracked changes, in-app chat, and diagram sharing. This flowchart creation app connects easily with a wide variety of platforms and cloud
services. It integrates with the most popular platforms and cloud services and is a good tool for software engineers. EdrawMax is a complex flowchart software with templates and functionality options for producing mind maps, floor plans, engineering diagrams, and more. It is compatible with Windows, Mac OS X, Linux, and the web, and has over
280 different types of diagrams. It has a wide range of functions and applications available and provides a significant learning curve for advanced users. Its integration is also limited. Microsoft Word is one of the tools you can use to create a flowchart. The downside of using it is that it is difficult to manage your flowchart templates with it and ensure
that all your team members are on the same page. If you want to make a flowchart in MS Word, here’s a video walkthrough that shows you how to do it. Google Docs does not have any built-in flowchart templates. Unlike Google Sheets, you can’t create a flowchart on it. However, you can improvise by launching the Google Drawing window to enable
you to create a flowchart. Here’s a video walkthrough of the entire process. Flowcharts can help you visualize the links between different data points in your spreadsheets. That way, you’ll be able to understand them better. If you want to make a flowchart in Excel, here’s a video that shows you exactly how to do that. You cannot create a flowchart
using PowerPoint. However, if you want to use a flowchart template in a PowerPoint presentation, you need to create the flowchart using MS Word, Excel, or Google Docs. Afterward, you can save the flowchart as an image either in JPEG or PNG formats. Once done, you can insert the flowchart image you’ve created previously in your PowerPoint
presentations and use it. Flowcharts are used in a variety of industries to analyze, create, document, and manage a process or procedure. The flowchart usually shows the steps in a procedure arranged in different boxes with arrows linking the boxes in a logical order. To use flowcharts as a solution model for a particular problem, you should
carefully follow the diagrammatic representation shape by shape, arrow by arrow, and text by text. Here’s a video tutorial that shows you how to use one: SweetProcess helps you to create and manage your company’s processes as flowchart templates seamlessly. If you have several procedures you follow to accomplish a specific goal, you can add
them as a process on SweetProcess. Here’s exactly how to do that: Step 1: Hover your mouse to the top-right corner of your SweetProcess dashboard, and click on “Create Process” Step 2: In the new window that opens up, you can start adding procedures to your process. Simply click on “Add Step.” Then click on the “Procedure” button. Step 3:
Create a new procedure or choose from previously created procedures to add to your process. Step 4: As you add procedures to your process, the flowchart will be created automatically in the dashboard. Here’s what it looks like: Step 5: Click on the “Print” button to download your flowchart as an image. Step 6: Click on the “Approve” button to make
the process go live on SweetProcess, and make it easy for all your team members to manage everything on the platform. As you can see, creating and managing your company’s flowchart templates on SweetProcess is easy and seamless. Many of our clients have used the SweetProcess flowchart creation tools to improve their business processes and
scale their profits. Laura Johnson from Brooks Law Group explained how our tool helped their business. “Employees were more dependent on me, even though it was on the server. They would have access to processes, but they would still lean more heavily toward me concerning questions and directives in some things,” she laments. So when Laura
was not available, employees would either be idle or make mistakes in trying to get things done. In the end, the organization suffered the consequences of its inaction or mistakes. She realized that empowering her team with all the information they need to do their job right, by documenting repetitive tasks in one place, is exactly what she needs. That
way, there are fewer emails and no more guesswork. Some of the remarkable benefits of SweetProcess to her company include: Effective business process documentation “I’ve not known us without processes. From my perspective, we have always had processes in place. SweetProcess, though, has made it easier to access the processes. It has made it
more organized because we have multiple offices,” she said. Standardize operations across the business “Switching to SweetProcess simplified our systems, made us more uniformed, and gave us easier access being a cloud place where we could go at any time. It’s structured and productive.” Today, employees across the organization’s five offices
work with the same procedures despite being in different locations. They access documents in the cloud from anywhere, at any time. The management plans better knowing that everyone is in sync with their agenda. Another client, Jamie Ramsden, pointed out their biggest pain point at Turkstra Lumber. The team at Turkstra Lumber was effective at
doing their jobs without documented processes, but they weren’t as coordinated as they should have been. They performed tasks in different ways, creating inconsistency across the organization. According to Jamie: “One of the things that prevent you from being correct and doing things better than you do now is when you don’t know what your
processes are or if everybody isn’t on the same page.” But when they realized that having everyone on the same page, working with the same processes and procedures, was imperative to achieve the great results they desired, they subscribed to SweetProcess. Interestingly, Jamie wasn’t convinced about using SweetProcess at first because he
thought the system was difficult to use. But he soon realized that SweetProcess was as easy as it gets. “Because I didn’t understand what the project was, I thought I needed something like a better version of Excel that would just be easier to use to record things. But recording processes with SweetProcess is the easy part.” With SweetProcess,
Turkstra Lumber’s initial experience with documenting business processes shows that documentation in itself isn’t a guarantee for efficiency. While the team did the right thing by documenting their processes, choosing to do so on Excel Sheets limited their results. The first thing that caught Jamie’s attention about SweetProcess was the ease of
documentation. Rather than creating tons of texts, SweetProcess offers a more visual approach that gives users a clear picture of what they are doing. Here’s what he said about the flowchart feature on SweetProcess: “The thing that caught my attention first was just something simple and visual, which is that SweetProcess automatically makes you

a little flowchart as you enter your steps for any process. People understand things in different ways and a lot of our staff like that if they can get a visual representation immediately.” SweetProcess saved these professionals, and it can save your business too. You can get started with a 14-day free trial of SweetProcess to create and manage your
company’s procedures and processes using a flowchart. Flowchart templates help you visualize your work process from a single document. When this is done, all the stakeholders in your organization will easily understand the workflow, identify unnecessary steps to remove and the ones to improve. Now that remote work is rapidly gaining popularity,
using flowcharts is a great way to reduce meetings in teams. Instead of spending long hours with your team members to explain how your procedures and processes work, you can provide a simple, visual technique for team members to grasp what they should do next in a step-by-step manner. Click here to download the flowchart templates relevant
to your industry and business. 5 Essential Steps To Getting a Task Out of Your Head and Into a System So You Can Scale and Grow Your Business!
25/03/2022 · 2. Swim Lane Flowchart Template. Download this Template. The swim lane flowchart template is designed for dividing up the steps of a process into different sectors. For your business, these different sectors could be time periods, teams, employees, or … Free Download Flowchart Templates Online. View flowchart templates gallery of
basic flowcharts, workflow diagrams, cross-functional flowcharts, BPMN, data flow diagrams. Through the sharing community, you can either upload and share your creative flowchart designs or explore suitable templates for personal use. Try It Now Buy Now. 12/12/2018 · Open Microsoft PowerPoint. Select the Insert tab at the top of the screen in
the Illustrations Group, and select SmartArt. In the SmartArt Gallery, click the Process tab. Here, you will find a large quantity of flowchart templates. Select the SmartArt process template that suits you, and insert it into the PowerPoint. 25/04/2018 · Horizontal Org Chart Template- Word. Process-focused organizations typically use a horizontal org
chart to show the flow of work on a product or service as it moves through the process from one person to the next. Use this template to identify areas for improvement by following your company’s linear process. Simply fill in the space provided ... 26/01/2022 · 57 Free Flowchart Templates for Word, PowerPoint, Excel, and Google Docs. Featured
Bonus Content: Download 57 Flow Chart Templates for FREE! Click Here To Download It. To improve efficiency in your organization, all team members and employees must be on the same page regarding your company’s procedures and processes. 10/05/2009 · 3. Add some text to your boxes, Right-Click a shape and Select Add Te x t. Then just enter
it in and format accordingly. 4. Now to add some lines to make your chart flow, there’s a … Tips 1: if you check the box of Save Thumbnail in the Save as dialog box, you will see the preview of your template in My Templates…. Tips 2: If you like, you can modify the template location. Within Ribbon interface: 1) File > Word Options > Advanced. 2)
Under the General section select File Locations and browse to choose your location. 25/04/2018 · Horizontal Org Chart Template- Word. Process-focused organizations typically use a horizontal org chart to show the flow of work on a product or service as it moves through the process from one person to the next. Use this template to identify areas for
improvement by following your company’s linear process. Simply fill in the space provided ... 31/05/2021 · Step 2. Draw rectangular shapes. Under the “Insert” tab, select the shapes dropdown and draw some rounded rectangles in the general areas where our question points will go. Step 2: Draw a bunch of boxes. Even with copying and pasting
shapes rather than drawing each new one, this step is time-consuming. 08/04/2020 · To make flowchart template word 2007 we need the following: Source: www.pinterest.com. Add a flowchart in word using smartart. To insert it, find insert tab on word ribbon and click it. Source: www.groovypost.com. Ad pc mag editor's choice. Ad lucidchart's
flowchart software is quick & easy to use. Source: www.gutjop.tk Choose a suitable template online or open a blank worksheet in Microsoft Word. When using Word, on the Insert tab, click “Shapes,” and on the bottom, click “New Drawing Canvas.”. You can then draw the symbols of your flow chart on the canvas using shapes from the Shapes list.
Typically, a rectangular box represents process stages. 18/08/2021 · Description. This template uses basic shape objects and lines to create an org chart. To add photos, delete the placeholder image and go to Insert > Pictures, then resize and crop the image as needed. The template contains an … Step #1: Know the purpose of your flowchart. Step
#2: Start with a template. Step #3: Add shapes and symbols. Step #4: Connect your shapes with lines and arrows. Step #5: Split paths or add decisions. Step #6: Customize your flowchart’s appearance. Flowchart Templates Organizational Flow Chart Template Word, by:visme.co. 6 best of free printable organizational chart how to make a flow chart
in microsoft word 2007 15 free church organizational chart templates word how to create an organization chart in word 2016 media plan flow chart template excel market research flowchart template flow chart free word excel … 722+ FREE CHART Templates - Download Now Adobe PDF, Microsoft Word (DOC), Microsoft Excel (XLS), Adobe
Photoshop (PSD), Google Docs, Microsoft PowerPoint (PPT), Apple (MAC) Pages, Google Sheets (Spreadsheets), Microsoft Publisher, Apple (MAC) Numbers, Adobe Illustrator (AI) 13+ Flowchart Examples for Beginners PDF. Step 2: Start adding shapes. Go to the “Insert” tab and click on either “SmartArt” or “Shapes.”. For SmartArt, those are a
collection of pre-made shapes in a gallery. For shapes, you have an option of selecting what you want and inserting it into the document. 12/12/2018 · Open Microsoft PowerPoint. Select the Insert tab at the top of the screen in the Illustrations Group, and select SmartArt. In the SmartArt Gallery, click the Process tab. Here, you will find a large
quantity of flowchart templates. Select the SmartArt process template that suits you, and insert it into the PowerPoint. Flow chart templates in Word is an easy way to create flow chart in Word. So creating a flowchart in Word is not that difficult. In order to create a flow chart in Word, you need to follow some simple steps. First and foremost, open a
blank Word document. Now, add shapes to the document you opened. Tips 1: if you check the box of Save Thumbnail in the Save as dialog box, you will see the preview of your template in My Templates…. Tips 2: If you like, you can modify the template location. Within Ribbon interface: 1) File > Word Options > Advanced. 2) Under the General
section select File Locations and browse to choose your location. Our Simple Flow Chart Templates in Word offer an easy flow design that makes it easy to tell any system, project, or a yes no decision. 722+ FREE CHART Templates - Download Now Adobe PDF, Microsoft Word (DOC), Microsoft Excel (XLS), Adobe Photoshop (PSD), Google Docs,
Microsoft PowerPoint (PPT), Apple (MAC) Pages, Google Sheets (Spreadsheets ... A process flow chart template uses symbols and diagrams to depict complex processes from start to finish. Just enter your process data to the Excel flowchart template, then export to automatically create the shapes and connectors that visually tell the story. A process
mapping template is a helpful tool to study and refine processes to increase ... Here's what you can do to draw a flowchart using Mockitt. Step 1: Start by registering for an account and verifying it to access the workspace. Login and create a project with your choice of template and device layout. Step 2: As the work screen opens … Free Newsletter
Template for Word 2007 and later. If you need to prepare or design a mailing in Word then you may Point rested to download a free newsletter Word template. This is a free example that you can download from Office website as a Word newsletter template and customize for your own personal needs. This template for Word lets you make ...
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